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Chapter 1 ¢ Introduction

Description

Picture

The LANpoint MOBILE features a Windows CE.NET (Windows CE version 4.1)
operating system, 64MB of SDRAM and 48MB Flash, Standard Memory 128MB of
SDRAM and 96MB Flash, an Extended Memory Option, a direct sunlight readable 3.5"
QVGA (240x320) Transflective Touch Screen display, open architecture, an Intel®
XScale™PXA255 400MHZ ARM processor, WIFI connectivity (Cisco Aironet 350
802.11b option), and a NEMA 3 (IP64) rugged, compact case.

The LANpoint MOBILE also has easy application development using Visual Studio.NET
2003 Professional, eMbedded Visual C++ 4.0 or your choice of terminal emulation
software, SQL CE - an SQL Server Client, Microsoft Access Message Queue (MSMQ),
and a docking station with spare battery bay. Options include terminal emulation
software (VT, IBM 5250, or IBM 3270), Compact Flash slot, RS/232 port, USB port, and
end caps for RS-232/USB ports or modem. For more information, see

|httQ://www.Iangoint.com|
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Introduction

Setup Requirements

Installation of PowerNet Twin Client requires, at a minimum, the following:
e A Pentium-class processor

o 32 MB of RAM

e 10 MB of free hard disk space available

e Microsoft Windows CE.NET operating system

ActiveSync needs to be installed on the PC before downloading files to the terminal.
For instructions, go to[http://www.msdn.microsoft.com]

Accessories

The following accessories are available for the LANpoint MOBILE:

e Battery Pack, 3.7V 2200mAh: LPMA-BAT22

e Battery Pack, 3.7V 4400mAh:; LPMA-BAT44

o Docking station without modem, USA - includes power supply and AC line cord:
LPMA-DOCK

o Docking station with modem, USA - includes power supply and AC line cord:
LPMA-DOCK-MDM

e Docking station without modem, EURO - includes power supply and AC line cord:
LPMA-DOCKE

e Docking station with modem, EURO - includes power supply and AC line cord:
LPMA-DOCK-MDME

Cigarette lighter power adapter cable: LPMA-CIG-CABLE

Modem End Cap: LPMA-CAP-MDM

RS-232/USB End Cap: LPMA-CAP-USB

Power Supply 12VDC, USA: LPMA-PS12

Power Supply 12VDC, EURO: LPMA-PS12

Cable USB-A to USB-B: LPMA-USB-AB

Cable, end-cap adapter, 10pin to DB-9 (M), 6-inch: LPMA-232ADAPT

Cable, serial, null modem DB-9 (F) to DB-9 (F): LPMA-232CABLE

Soft-sided Case, includes belt clip/belt loop: LPMA-SOFTCASE

Soft-sided Case, includes belt clip/belt loop: LPMA-SOFTCASE

Shoulder Strap for Soft-sided Case: LPMA-SHSTRAP

Replacement Stylus, 4-pack: LPMA-STYLUS4

128 MB Secure Digital/Multi-Media memory card: LPMA-SD128

128 MB Compact Flash memory card (user-accessible CF slot models only):

LPMA-CF128

o Bluetooth Radio Compact Flash card (user-accessible CF slot models only):
LPMA-BLU

e Terminal emulation thin-client license - configurable VT100, VT220, IBM3270, or

IBM5250: LPMA-TE-MOBILE
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Synchronization Tools

Synchronization Tools

At least version 3.1 of ActiveSync is required for desktop synchronization and
communication. ActiveSync is freely downloadable from the Microsoft web site,
at|http://www.microsoft.com/downloads|

Release Note

The 7.2.0 version of Twin Client for the LANpointMOBILE includes support
only for linear barcodes.
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Chapter 2 - Terminal Setup

Downloading from the Web

The PowerNet Twin Client software package can be downloaded from the Connect web

site at|http://www.connectrf.com} Click on Partner Services and then click on Software
Downloads. Select the file named PowerNet Twin Client for Intelligent Instrumentation.

Running Setup from a Download File

The downloaded file is a compressed archive. After extraction using a utility such as
WinZip or PKWARE, folders are created on the hard disk as shown in the following

figure.
I arme | Size | Type
[ disk File Folder
[ disk? File Falder
[ disk3 File Falder
[ diskd File Falder

Click on the Disk1 folder to view the files as shown in the following figure.

Mame Sizel Type

ETE 232KB EX_File

1 _150el... 27KE  Application

_Setu... KB Application Estension
B syst... 172KE  WirZip File

8] _sysl... 4B HDFR File
ED_usert... KB WirZip File

8] _uzerl... EKE  HDR File

Data.tag 1KE  TAG File

B datal . IE0KE  winZip File

8] datal.... 13KB  HDR File

lang.dat EKE  DAT File

layaut.... KB BIM File

] os.dat KB DAT File

@ zetup.... 185KE  Bitmap Image
QSEtup.... FOKB  Application

Setup.ini 1KB  Confiquration Settings
-q.[}) zetup.ing BBKEEB  Internet Communication 5.
setup.lid 1KE  LID File
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Terminal Setup

Click on the Setup application and proceed to the section entitled Installation for further
instructions.

Installation
The InstallShield wizard runs and presents the following screen.

Welcome

Ywelcome to the Powertet TwinClient Setup program.
Thiz program will inztall Powert et TwinClient on wour

- computer.

It iz ztrangly recommended that pou exit all Windows programs
before running thiz Setup program.

Click Cancel to quit Setup and then cloze any programs you
have running. Click Mest to continue with the Setup program.

WARMIMG: Thiz program iz protected by copyright law and
international treaties.

|Inauthaorized reproduction or distribution of this program, or any
portion of it, may result in severe civil and ciminal penaltiez, and
will be progecuted to the maximum extent poszible under law.

Cancel |

Click on Next to begin the installation process.
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Installation

Choosze Destination Location

Setup will ingtall PawerM et TwinClient in the following folder.
Toingtall to thiz folder, click Mext.

Toinzstall ta a different falder, click Brovwse and zelect another
folder.

Y'ou can chooze not toinstall PowerMet TwinClient by clicking
Cancel to exit Setup.

C:5Power et TwinClient Browse... |
Cancel |

To change the default Destination Location, click on Browse and select a location. Then
click on Next.

" Destination Folder

¢ Back

Select Program Folder E

Setup will add program iconz to the Program Folder listed below,
f'ou may twpe a new folder name, or select one from the existing
Folders list. Click Mest to continue.

Program Folders:

Powerte

E wisting Folders:

Adrminiztrative Tools [Common) -
Adobe Acrobat 4.0

Lotus Applications

Microzoft Office Tools

M artan Antiins

] Etn 22

Startup

windows NT 4.0 Option Pack hd

< Back I Mest = I Cancel |

The default folder is PowerNet. This default may be changed either by selecting an
existing program group or by typing in a new name at the prompt. Then click on Next.
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Terminal Setup

Setup Complete

Setup haz finished copying files to your computer,

Before you can wze the program, you must restart Windows or
your cormputer.

= Yes, | want to restark my computer o

™ Ma, | will restart my computer later,

Remove any disks from their drives, and then click Finish to
complete zetup.

¢ Hack I Finizh I

When the installation is complete, reboot the system to initialize the Twin Client
software.

a. To reboot the system immediately, click on Finish.

b. To reboot later, click on the option to restart the computer later, and then click on
Finish.

Running the Manager

The PowerNet Twin Client Manager is the utility that manages the terminal software and
configurations.

Select Start, Programs, PowerNet, and Twin Client Manager. The PowerNet Twin
Client Manager screen appears as shown in the following figure. This is the
administrator's main screen, and all functions are accessed from its menu bar, toolbar, and
tabs.

Menu Bar

The menu bar provides access to the functions used to configure the terminals and
manage their software.

Untitled - Twin Client Manager [_ O] x|

FEile  Terminal Object Editarz Settings Tool: Yiew Help

0|2|E| w5 2 2]
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Quick Start

Toolbar

Found under the menu bar, the toolbar provides shortcuts to major features. The toolbar
can be turned on or off by changing the Toolbar parameter found on the View menu. The
shortcuts available from the toolbar are as follows.

Create a new terminal configuration.

Open an existing terminal configuration.
Save the current terminal configuration.
Download the configuration to the terminal.

Download software to the terminal.

Configure terminals automatically over the wireless network.

= B E - R o

View the PowerNet Twin Client Manager version.

The PowerNet Twin Client Manager is now successfully installed and ready for use.
Quick Start provides detailed instructions for quickly configuring the terminal and
starting a Telnet session.

Quick Start

Quick Start describes how to prepare the Twin Client Manager and the Intelligent
Instrumentation terminal for a Telnet session with the host. Following an initial setup
procedure, the terminal software and configuration are managed automatically over the
wireless network.

Configuring the Manager

You will configure the Twin Client Manager to meet site-specific requirements, and then
prepare it for the automatic management of the terminal software and IP addresses. This
simple procedure will require only a few minutes to complete.

Setting the Emulation

Click on Start, Programs, PowerNet, and Twin Client Manager. Select the Settings
menu, as shown below.
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Terminal Setup

Untitled - Twin Chient Manager M=l E

File Temunal Object Editor: @SEWGEEE Tool: “Yiew Help
0= E LEI E % Ermulation... |

| | | | I— Servers...
MHew-Ervinon Settings. ..
Terminal Operatian...
Options...

k.eybaard | Displa_l,ll Scannel I F'rinterl Mizc I

Click on Emulation, select the desired emulation, and click on OK.

Emulation X

Select the terminal emulation type:

w220
5250
3270

Cancel |

Setting the Servers

The Servers are the Telnet host systems the terminals will access.

F 4 Untitled - Twin Client Manager — |0 x
Eile  Terminal Object Editor: EEUGEEN Tool: Yiew Help

0|es|E| 6|5 25

K.eyboard | Displayl Scannel

I F'rinterl fisc: I

Terminal Operation. ..
Options...

L o

To set these addresses from the Settings menu, click on Servers and then click on Add.
Enter the name of each server, its IP Address and IP Port (normally 23 for Telnet
servers), and emulation type. Then click on OK.
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Quick Start

Servers

Server Mame | |P Address | IF Paort | Terminal Tupe |

[

add | e | Defeiel | Loscl. |
Save b, |
] I Cancel |

Repeat this step for each Telnet server the terminals are required to access. If an error is
made in the name, IP Address, IP Port number, or Terminal emulation type, click on the
line that is in error, and then click on the Edit button to make the corrections. Use the
Load button if you want to load an .svr file. Use the Save As button if you want to save
your file as an .svr file.

Setting Terminal Operations
In the Twin Client menu under Settings, choose Terminal Operation.

[Ed untitled - Twin Client Manager =] E=
FEile  Terminal Object Editor: @GN Tool: Yiew Help

Dlﬁlnl .lﬂlﬁl E Ernulaticr...

Servers..
Mew-Environ Settings. ..

K.eyboard |Displa_u| Scannel I F'rinterl Mizc I

Termminal Operation. ..

Options...

-

Run AirLoader on terminal can be selected, and the AirLoader server IP address can be
entered.

The Windows CE options of Run application at startup and Hide task bar can be
selected. Also, there is a CE option Use GUI menus and screens that makes the
terminal program act more "Windows-like".

The Code page setting determines the Windows font code page that will be used on the
terminal. The default is zero, which means that the terminal will use the standard Unicode
code page. This option is necessary to turn on character sets for foreign languages.

For more information on code pages, see the document entitled “Code Pages” at
[http://www.connectrf.com/faq.htm]
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Terminal Setup

Terminal Operations il

¥ Bun aitloader on terminal

Airloader zerver [P address: I

—Windows 4 Windows CE ophiong

o Cancel
¥ PFun application at startup

d

™| Bun multiple emulations
™ Hide task bar

[ Use GUI menus and screens

Code page; I':'
Seanner Serial Bart: |<default> 'I

Click on OK when finished.

Setting Terminal Model

Under Settings, choose the Options menu as shown.

Untitled - Twin Client Manager M=] E3

File  Temnal Object Editor: @SEWEN Tool: “iew Help

Dlﬁlnl lﬁlﬁl E Ernulaticr. .

Servers...
K.evboard | DiSp|E|_|,II Scannel HEW'_EW"D” Sgttmgs... I F'rinterl bz I
Terminal Operatian...
_ Dptions. ..
Select terminal model, desired radio type, and COM port.
2-8 Supported Equipment Manual e May, 2006



Quick Start

TwinClient Terminal Loader x|

b anufacturer; Terminal kodel:

LanPaintCE
LanPointCE-A5
Intellnst LanPointCEdatMET
LanPointCEdotME T -45
LanPointPlus
LanPointPlus-A5
TimeFaint ;I

R adio Type:

Communications Port; I COwA 7 I

| [k I Cancel |

Saving the Configuration

Click on File and Save As. Enter a name for this configuration.

Untitled - Twin Client Manager =] E

A=W Terminal Object Editars Settings Yiew  Help
HEW Etr|+N ?
Open... Chrl+0 ﬁl _|

Save Ctrl+5

For the purposes of this example, the name is vt100.

Save in: Ia brinclient j ﬁl

|1 terminal
zample. cf

File name: I w1 00.cf | Save I
Save as type: | Twin Client Config Files [*.cf =] Cancel |
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Terminal Setup

Setting Airloader Auto-Configuration

The configuration download and IP address assignment for each terminal will take place
automatically by setting the Airloader Auto-Configuration options.

Llntitled - Twin Client Manager M=l E3

Yiew Help

File Teminal Object Editors  Settingz

DI@IE' 'L,E'l%l ﬁl gl Autharization,..
I ' : . Airloader. .. |_

Click on the Airloader option in the Tools menu.

Note: If the Airloader Auto-Configuration window does not display the options, click on
the Advanced<< button.

If multiple network adapters are installed on the PC, ensure that the desired network
adapter is selected. Change the adapter selection by clicking on the Change button.

Terminal Auto-Configuration x|

New Group [Defaul] The Termninal/Group Auto-configuration manager gives you

the ahility to keep terminalz up to date automatically with the
latest settings and software. Ulze the default group. or create
additional terminal groups for more complex environments.

Advanced << |

W allow terminals to be automatically configured via FF

¥ Sunchronize Configuration Files
¥ Sunchronize Program Files

I | Sonehronize Driver Files

7| Sunchronize BI0S Fles

¥ Configure [P Parameters (local segment only]
Mehwaork Adapter:

I[EI] PCl Fast Ethemet DEC 2114 Change,,_l
Addresses. . |

This powerful software management tool is described in detail in Airloader Auto-
Configuration. For now, it is sufficient simply to use it for assignment of the initial
terminal configuration and IP address, both of which can be easily changed later. Ensure
that all of the check boxes are checked as shown above.

To assign terminal IP addresses automatically over the wireless network, check all of the
boxes as shown above. Then click on the Addresses button and enter the desired range
in the From and To boxes as shown in the following figure.

2-10
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Quick Start

Segment Addrezs Assignments x|

w206.183.67.240 Agent Address: 206.183.67.217
[1206.183.67.241
[1206.183.67.242
[1206.183.67.243
[]206.183.67.244
[]206.183.67.245
[1206.183.67.246
[1206.183.67.247
[1206.183.67.248 fdd
[1206.183.67.249

Subnet Mask:  255.255.255.128

Addrezs Bange

Eran: |2DE.183.E?.24D To: |2DE.183.E?.249

Bemove | Select All |

Femave Al |

[ Checked indicates address assigned

Cancel |

After setting the address range, click on OK to return to the Airloader Auto-Configuration
screen and then click on the box next to Terminal/Group Manager.

T erminal Auto-Configuration

Click on the + sign in front of Terminal/Group Manager to access the default terminal
Group. Next, click on the New Group icon and use the Browse button to select the
configuration file saved earlier.
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Terminal Setup

Terminal Auto-Configuration - Airloader ﬂ

=B E TerminalfGroup Manager

@ Mesy Group [Default] W Active

Configuration File

I Browsze... |

&+ Use default zerver file [power. net)

" Use a zaved server file [*.svi]

I Erowse,.. |

—&uto-Group
[T Default
[T Manutacturer [Inkelnst j
™ Type L&NPointtobils |
™ Radin cisco350 =]
I Emulation | 2270 =]
" Segment [P fAiddress: [0.0.0.0
Met kaszk: (0.0.0.0

Farce Reload... | Thin Mode. .. Schedule. ..

Check the Active box, and the system is now configured to automatically download IP
addresses, software, and configuration files to the terminals. Click on the [ box in the
upper right corner to return to the main menu.

Note: The software does not need to be authorized now. It can be authorized later, after a
Telnet session has been established. The procedure is described in Authorizing
PowerNet.

Configuring the Terminal for Download

The terminal download requires a serial connection between the terminal and the PC
through a cable. In preparation for this download, connect the cable to the selected serial
port on the PC and to the LANpoint MOBILE terminal.

On the PC, click on Start, Programs, PowerNet, and Twin Client Manager. Under the
Terminal menu, choose Send Program Files to Terminal, as shown in the following
screen.

sample_-::f - Twin Chent Manager |_ O] x|
File Object Editars Seftings: Tool: “iew Help
Send Configuration Files ta Terminal
Beceive File from T erminal

Send Program Files to Terminal

2-12
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Quick Start

The following screen is displayed.

Twin Clhient Manager E

& Wwiould you alzo like to load the configuration files?

Hao | Cancel |

Choose Yes at the prompt. The following screen is displayed.

Twin Client Manager |

Pleaze werify that ActiveSync i running. IF not,
connect the device to start ActiveSync. Then press

Ok when ActiveSync is running.

Click on OK.

The PC is now configured to download to the terminal.

Booting the Terminal

At any time it is necessary to update the terminal software and/or configuration, the
terminal must be booted.

A warm boot is performed by selecting Start — Programs — Restart.
A cold boot is performed by simultaneously pressing the Shift + Func + Scan keys.

A successful wireless connection is indicated by the display of the following Twin Client
main menu.

Twin Client
© 1991-2006, Connect, Inc.

Keypress to continue

Note: The date of 2006 is updated on the terminal at the time of a new release.

The terminal is now ready to establish a Telnet session with the host system.
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Terminal Setup

Starting a Telnet Session

At the Twin Client main menu on the terminal, press any key to establish the connection.
Until the terminal has been authorized, the following screen is displayed.

RECOVERABLE ERROR
Terminal not

Authorized for

Twin Client

Keypress to continue...

It is not necessary to authorize the terminal at this time, so press any key to continue. The
terminal will establish a connection with the host system and start emulation. If the
terminal fails to connect to the host, refer below for the causes and corrective actions.

Failure Cause Corrective Action

Incorrect Host IP address Correct the Host List address on the terminal. Refer to
Terminal Setup Using Twin Client Menu.

Incorrect netmask value Access the Edit Functions menu. Correct the netmask
value. Refer to Terminal Setup Using Twin Client Menus.

Error Indication Possible Cause Corrective Action

NOT Associated Invalid NETID Run current radio setup program and
set NETID to match the access point.
See Terminal Setup Using Twin Client

Menus.
No AirLoad AirLoad Manager not | Ensure that the PC with Twin Client
Manager Found. active, or not installed | Manager is on the same segment and

on the LAN segment. | that the PC is operating. If the PC is
not on the same segment, enter the
address of the PC in response to the
terminal prompt.

Manager not Active | Previously identified Same as above
AirLoad Manager is no
longer found.

Unable to open IP stack on terminal Reload Program Files and reboot.
connection failed to load.
Timeout waiting for | Transient Reboot terminal. If problem persists,
data communications check the RFSYNC.log in the
failure PowerNetTN directory.
Download aborted Socket closed during Ensure that the PC is operating. Reboot
download terminal and retry.
Manager inactive PC not operating Restart the Airload PC server.

After a Telnet session has been successfully established, the terminal will remain in
session for a maximum of 30 minutes at a time until it has been authorized. Once
authorized, there is no software restriction on the session time. The instructions for
authorizing the terminal are presented in Authorizing PowerNet.

2-14
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Standard Setup

Standard Setup

The default terminal setup is sufficient for most installations. However, to meet site-
specific requirements, it may be necessary to customize terminal operation. The standard
setup options simplify this process and can be modified by the following methods:

e Using the Twin Client Manager.
e Using the Twin Client terminal menu system.
Standard Setup describes how to use the Twin Client Manager and the terminal menu

systems to set up the terminal. Also described are the methods for authorizing the
terminal software.

Setup Using Twin Client Manager

The Twin Client Manager provides a Standard Settings tab for automatic setup of the
terminals. Under the View menu, choose Standard. The options within this tab vary
according to the emulation selected, each of which is described below.

VT Settings

Select the VT emulation setup by clicking on the Settings menu and then the Emulation
menu, as shown below.

Untitled - Twin Client M anager M= E3
File  Temminal Object Editars Tools “iew Help
D|Ei-”|ﬂ| LE||'E| 5
SEMVErS...
Standard Settings | Hew-E rvinon Settings. ..
Terminal Operation...
Optionz...
Then click on the vt100 or vt220 selection, as shown below.
Emulation X

Select the terminal emulation type:

w220
5250
3270

k. I Cancel

Click on OK after the selection is made, and return to the main Twin Client Manager
menu. The standard settings tab will now reflect the settings for VT emulation.
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Terminal Setup

Untitled - Twin Client Manager -0l x|

File Terminal Object Editors Settings  Toaols  Wiew  Help
0|8 %% 2| 2

Standard Settings |

Quadrant Mode h

Font

Fl:untSizel'IU 'I

Biold Font r
Key Click v
Frinter Type: I none j
Ready [vt100 Intellnst |LAMPointMobile 2

Quadrant Mode

The scrolling list defines the rules by which the terminal display is positioned in the
larger host display. As defined by Twin Client, quadrants are fixed position “windows”
in the host display, and the terminal display is located on whatever quadrant contains the
current cursor position.

Off disables quadrant processing and Twin Client simply centers the current host
input field in the terminal display.

On enables quadrant processing. However, input fields that cross quadrant
boundaries result in a shift to the left in order to locate as much of the current input
field on the terminal display.

Soft always positions on a quadrant boundary regardless of input field boundaries.
Viewing keys are enabled.

Hard is the same as Soft except the viewing keys are disabled.

Lock locks the terminal display origin (upper left corner) to fixed row and column
(x,y) coordinates in the host display. The coordinates are zero-based.

Font

The Font Size scrolling list offers font size options. The Bold Font check box enables
(checked) or disables (unchecked) the display of characters in bold font.

Key Click

This check box enables (checked) or disables (unchecked) audible key clicks from the
terminal. The default value is on (checked).

2-16
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Standard Setup

Printer Type

This scrolling list selects the attached printer type. The default value is none, indicating
that no printer is attached.

5250 Settings

Select the 5250 emulation setup by clicking on the Settings menu and then the
Emulation menu, as shown below.

Untitled - Twin Client Manager [_ O]

File Terminal Object Editor: @EGGWEE Tools Yiew Help
Ol = H Ermulation...
Do || 55| 2 WEASa
Standard S ettings | Mew-Environ Settings. ..
T erminal Operation...
Options. .

Then click on the 5250 selection, as shown below.

Emulation x|

Select the terminal emulation type:

] I Cancel

Click on OK after the selection is made, and return to the main Twin Client Manager
menu. The standard settings tab will now reflect the settings for 5250 emulation.
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Terminal Setup

Untitled - Twin Client Manager =10l x|

File Terminal Object Editors  Settings  Tools  Wiew  Help

D= 55| 22 2

Standard Settings |
Quadrant Made | off -
Font

Fort Size | vI
Bold Fant -

ey Click v

Frinter Type: I hone j

Ready 5250 [Intellnst LANPaintMoble 4

Quadrant Mode

The scrolling list defines the rules by which the terminal display is positioned in the
larger host display. As defined by Twin Client, quadrants are fixed position “windows”
in the host display, and the terminal display is located on whatever quadrant contains the
current cursor position.

Off disables quadrant processing and Twin Client simply centers the current host
input field in the terminal display.

On enables quadrant processing. However, input fields that cross quadrant
boundaries result in a shift to the left in order to locate as much of the current input
field on the terminal display.

Soft always positions on a quadrant boundary regardless of input field boundaries.
Viewing keys are enabled.

Hard is the same as Soft except the viewing keys are disabled.

Lock locks the terminal display origin (upper left corner) to fixed row and column
(x,y) coordinates in the host display. The coordinates are zero-based.

Font

The Font Size scrolling list offers font size options. The Bold Font check box enables
(checked) or disables (unchecked) the display of characters in bold font.

2-18

Supported Equipment Manual e May, 2006



Standard Setup

Key Click

This check box enables (checked) or disables (unchecked) audible key clicks from the
terminal. The default value is on (checked).

Printer Type

This scrolling list selects the attached printer type. The default value is none, indicating
that no printer is attached.

3270 Settings

Select the 3270 emulation setup by clicking on the Settings menu and then the
Emulation menu, as shown below.

Untitled - Twin Client Manager =l

File Teminal Object Editors EEh-0 Tool: “iew Help
Ol E Emulation...
D= 6|5 25 R
Standard S ettings | Mew-Environ Settings. ..
T erminal Operatior...
Options...

Then click on the 3270 selection, as shown below.

Emulation x|

Select the terminal emulation type:

] I Cancel

Click on OK after the selection is made, and return to the main Twin Client Manager
menu. The standard settings tab will now reflect the settings for 3270 emulation.
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Unl:il:IEd - Twin Client Manager =10 x|

File Tetminal ©Object Editors Settings  Tools  Yiew Help
O|=|E| 6|5 2 2]

Standard Settings |

Quadrant Made | off -

Fant

Font Size "I

Bold Fant I
K.ey Click v
Frinter Type: In-:une j
Ready 3270 |IntelInst LAMPointMobile 2

Quadrant Mode

The scrolling list defines the rules by which the terminal display is positioned in the
larger host display. As defined by Twin Client, quadrants are fixed position “windows” in
the host display, and the terminal display is located on whatever quadrant contains the
current cursor position.

Off disables quadrant processing and Twin Client simply centers the current host
input field in the terminal display.

On enables quadrant processing. However, input fields that cross quadrant
boundaries result in a shift to the left in order to locate as much of the current input
field on the terminal display.

Soft always positions on a quadrant boundary regardless of input field boundaries.
Viewing keys are enabled.

Hard is the same as Soft except the viewing keys are disabled.

Lock locks the terminal display origin (upper left corner) to fixed row and column
(x,y) coordinates in the host display. The coordinates are zero-based.

Font

The Font Size scrolling list offers font size options. The Bold Font check box enables
(checked) or disables (unchecked) the display of characters in bold font.
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Key Click

This check box enables (checked) or disables (unchecked) audible key clicks from the
terminal. The default value is on (checked).

Printer Type

This scrolling list selects the attached printer type. The default value is none, indicating
that no printer is attached.

Terminal Setup Using Twin Client Menus

For compatibility with other PowerNet products, the PowerNet Twin Client for
Intelligent Instrumentation also supports the standard Twin Client configuration menu
system on the terminal. This menu system is accessed by pressing uppercase C at the
Twin Client main menu below.

Twin Client
© 1991-2006, Connect, Inc.

Keypress to continue

The following menu appears in thick (Telnet) mode:

Edit Server/Host IPs
Edit License Key
Switch Client Modes
Run Client Emulator
Exit to OS

The following menu appears in thin (Server) mode:

Edit Server/Host IPs
Run Site Survey
Switch Client Modes
Run Client Emulator
Exit to OS

Use the Up arrow and Down arrow keys to navigate the menu, and press Enter to select
the highlighted option. Each menu option is described below.

Edit Server/Host IPs

If the host IP address or addresses were not pre-configured as described in the Setting the
Servers section of Configuring the Manager, or if you wish to change those settings using
the terminal menus, select this option and enter up to four Host IP addresses as required.

Host O
IP 206.183.67.155
Port 23

<F3> Save <F7> Quit

Press F3 to save the configurations.
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Edit License Key

The client software can be authorized automatically, as described in the next section,
Authorizing PowerNet. This menu option permits authorization of each terminal
manually. Select this option to obtain the terminal’s Identification Code, used to obtain
the Authorization code from the Connect web site, as described in the next section.

The 12-digit value displayed at the top of the terminal screen is the Identification Code
for the terminal.

00AOF826E614
Authorization

not authorized

<F3> Save <F7> Quit

Type the Authorization code into the field as it appears on the web site. Punctuation
characters, such as the hyphen (-), are required. Press F3 to save the Authorization code.

Run Site Survey

This option (a feature of Spectrum 1) is applicable to Release 5.0 and may be obsolete for
your terminal.

Switch Client Modes

The PowerNet Twin Client normally operates in Telnet mode, which provides direct
connection to Telnet hosts. It can also operate in Server mode, through a PowerNet
OpenAir server. Select this menu option to switch between Server and Telnet modes of
operation. Note that the host socket address for the PowerNet OpenAir servers is 1800,
which must also be changed in the Edit Server/Host IPs menu described above.

Run Client Emulator

After all desired changes have been made, select this option to return to the Twin Client
main menu. Then press any key to establish the Telnet session and begin emulation.
Refer to the Starting a Telnet Session section for further instructions.
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Authorizing PowerNet

Each PowerNet Twin Client will run for 30 minutes at a time without authorization.
Uninterrupted operation for a production environment is the result of authorizing the
software.

The Twin Client Manager can automatically authorize the terminal over the wireless
network if the following requirements are met:

e A PC running Twin Client Manager is connected to the wire LAN segment with at
least one access point within range of the terminal.

e The System ID of the PC on which Twin Client Manager is installed has been used to
obtain a site license Authorization code from the Connect web site.

To obtain the Twin Client Manager’s System ID, click on Authorization under Tools.

Untitled - Twin Client Manager =l

Eile  Terminal Object Editors Setting: [ Wiew  Help
D| || 6T 2 2] [ futhozation.. |

Airloader...

Screen YW atcher...
Terminal Meszenger...
BF karitar...

Standard Settings |

Server Transfer...

The Authorization window is displayed as shown below.

Authorization

Your Syztem 10 is: IEEFBEB.&?

Twin Client version: 7.2.0

E nter your Autharization Code below:

Apply |

The spstem iz MOT curently authorized :
Sddlllicenses.. |

— Authonzed Terminalz

Total Authorized: II]_
In Use: IU_ Lizting... |
Remaining: II]_ |

Cloze
Details... |

W Enual Suthanzation,.. |

Transtenduthonzation... |
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Go to|http://www.connectrf.com| Click on Partner Services. Click on the Generate
Authorization icon at the top of the page. Follow the directions on the web site.

Authorized Terminals

The number of terminals authorized, the number of terminals in use, and the number of
terminals remaining is provided in the Authorized Terminals box on the lower left side of
the screen.

Click on the Details button to number the options in the screen below in the order of your
priority.

Note: The terminal may or may not be able to utilize the Formatter feature depending on
its Authorization codes.

Authonization Details E

The following list shows the number of terminalz that can be
authorized by thiz Twin Client manager bazed on optionz
granted by zite icenzes.

Fe-order the entries to priontize which options are given to
terminalz authonzed by Airloader.

Pricrity | Option(z] | Hemaining|
1 Screen farmatter only 0
2 Both Farmatter and Plus 0 e
3 Twin Client Plus anly 0 -
4 Standard features anly 0
Do

* Staging not enabled.

Cancel |

Click on an option and move it using the Up and Down buttons.
Click on OK when finished.

The Manual Authorization button is an alternate method of obtaining an Authorization
code for a terminal. This method does not utilize Airloader, as does the other method.
Click on this button, manually enter your MAC address in the screen that appears, and
click on OK. This enables you to generate individual Authorization codes.
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Adding Licenses

The Add Licenses feature is used when adding additional licenses to an already site
licensed Twin Client Manager. (i.e. Twin Client Manager is licensed for 10, and the
customer purchases another 10 licenses to make a total of 20.)

From Twin Client Manager, choose Authorization from under the Tools menu. Click on
the Add Licenses button.

Authorization

“Yaur Spstem 10 is: IEEFBEB.&?

Twin Client verzion: 7.2.0

Enter pour Autharization Code below:

Apply |

The system iz HOT currently authorized :
Add Licenses. .. |

— Authonized Terminalz

Total Authorized: IEI
I Ulse IU Liztirg... |
R emaining: IEI

Detailz... |

Hamual Suthenzation. . |

Transfer .ﬂ-.l,rthcurizatil:un...l

Cloze |

A pop-up box appears with the Machine ID and a space for the additional license’s
Authorization code. Enter the additional license’s Authorization code and click on OK.

Use the Machine ID in the pop-up box instead of the original Machine ID to get your
Authorization code.

If adding users, click on the Add Licenses button before generating the Authorization
code to get the most current Machine ID.
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Transferring Licenses

The Transfer Licenses feature is used when moving a site license from one PC to
another. After Twin Client Manager is installed on a new PC, you will need the
System/Machine ID for it.

From Twin Client Manager, select Authorization from under the Tools menu.

Click on the Transfer Authorization button on the old PC. You will be asked for the
new System ID. Enter this new System ID. It will generate an Authorization code for
the new PC's Twin Client Manager.

Authorization

“Yaur Spstem 10 is: IEEFBEB.&?

Twin Client verzion: 7.2.0

Enter pour Autharization Code below:

Apply |

The system iz HOT currently authorized :
Add Licenses. .. |

— Authonized Terminalz

Total Authorized: IEI
I Ulse IU Liztirg... |
R emaining: IEI

Detailz... |

Hamual Suthenzation. . |

Transfer .ﬂ-.l,rthcurizatil:un...l

Cloze |

Note: This feature only works if there are licenses remaining on the old PC.
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Listing

Click on the Listing button to view Authorization codes used along with corresponding
serial numbers.

The Authorization codes used along with their corresponding serial numbers will appear.

Authorization Codes Issued Ed |

Serial Murnber | Autharization Code |

Click on OK when finished.

Click on the Close button when finished.
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Software Management

In addition to providing functions for the download of files to the terminal, the Twin
Client Manager also provides for the management of terminal software and
configurations automatically over the wireless network.

Software Management describes the automated capability in detail. Additional manual
operations involving serial download options are described at the end of it.

Airloader Auto-Configuration

The Airloader Auto-Configuration form is accessed from the Twin Client Manager Tools
menu. Select Airloader.

Terminal Auto-Configuration

E Terminal/Group Manager . . . .
The Terminal/Group Auto-configuration manager gives you

the ahility to keep terminalz up to date automatically with the
latest settings and software, Use the default group. or create
additional terminal groups for more complex environments.

Advanced << |

IV Allow teminals to be automatically configured via RF

v Synchionize Configuration Files
v Synchionize Program Files

™| Sprichronize Driven Files

™| Syrnichronize BIOE Files

v Configure [P Parameters [local segment onlyk
Mehwark Adapter:

I[EI] PCl Fast Ethemet DEC 2114 Change,,_l
Addresses. . |

Note: If no options are displayed, click on the Advanced<< button.

Enabling Automatic Downloads

Click to put a check in the box that allows terminals to be automatically configured via
RF to enable automatic downloading. In the event that another PC on the network is
already configured and active, the following warning message is displayed.

RF Sync Manager |

IIhable to autarnatically configure kerminals.
There iz already another computer of this netwark
gegment nning the ArLoader zerver. [206.183.67.22E]
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Synchronizing Configuration Files

Click to put a check in the Synchronize Configuration Files box to enable automatic
synchronization of configuration files on the terminal. When the terminal is booted, its
configuration files will be compared with the most recent on the PC. The terminal is
updated automatically if it does not have the latest revision.

Synchronizing Program Files

Click to put a check in the Synchronize Program Files box to enable automatic
synchronization of program files on the terminal. When the terminal is booted, its
program files will be compared with the most recent on the PC. The terminal is updated
automatically if it does not have the latest revision.

Automatic IP Address Assignment

An IP address does not need to be assigned to the terminal. The terminal can find the
Airloader server automatically.

Creating New Groups

New groups, with different configurations, can be created by clicking on
Terminal/Group Manager and then clicking the right mouse button as shown.

Terminal Auto-Configuration

E Terminal/Group Manager
Refrezh

MHew Group

After the new group has been created, the group settings option becomes available for
change, as shown below.
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Terminal Auto-Configuration - Airloader x|

=~ EE Terminal/Group Manager _
- #38 Mew Group [Default] I Active

..... Mew Groupl Configuration File

I Browse. .. |

% Lze default zerver file [power.net]
i~ Usze a saved server file [*.zvr)

I Browse... |

—Auto-Graup
[ Default
™ Manufacturer |Inielnst j
[~ Type L&NPointtobile |
I~ Radin cizcods0 ]
™ Emulation 3270 j
[ Segment [P Address; [0.0.0.0
It M azk: (0.0.0.0

Force Reload... | Thin Mode... Schedule...

After the Configuration File and all of the other parameters have been set, the group is
made active by clicking on the Active check box.

2-30 Supported Equipment Manual e May, 2006



Software Management

Terminal Auto-Configuration - Airloader E[

- E TerminalfGroup Manager .
@ Mew Group [Default] I Active

L1 Group Configuration File
I Browse. .. |

£+ Use default zerver file [power.net)

" Use a saved server file [* zvi]

I Brawse,.. |

— Auto-Group
[T Default
[ Manutacturer |lrkelnst j
I~ Tupe LéNPointtobile |
I™ Radio cisco350 |
I~ Emulation  |3270 =]
I Segmert  [F Address: [0.0.0.0
f et kfazh: (0.0.0.0

Faorce Reload... | Thin Mode. .. Schedule...

Clicking on the Thin Mode button will cause all terminals in this group that are
currently running in thick mode to be switched to thin mode the next time Airloader
iS run on the terminal.

Click on the Schedule button to view a dialog box for scheduling an automatic Airloader
update.

Auto-configuration Scheduling

¥ Update group members at |‘|2 j : II:IIJ j Iamj

Ilpdate How... |

k. I Cancel |

Select the desired time and click on OK. Click on Update Now and the Airloader “push”
capability controls terminals from this end.
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Setting the Segment

Checking the Segment button restricts a terminal group to a range of IP addresses. The
IP Address can be any valid address on the segment, as it is used only to identify the
segment. The setting of the Net Mask can be used to restrict the range. This feature is
useful for segregating terminal groups by location.

Setting Force Reload

Clicking on the Force Reload button forces all terminals within a group to be
automatically updated. The following warning message appears.

RF Sync Manager |

Thiz will zause all applicable files to be reloaded on all
terminalz in this group, e you sure?

Click on the Yes button to force the reload.

Setting the Default Terminal Group

New terminals that have not yet been assigned to any group are initially assigned to the
default group in effect when they are booted.

Terminal Auto-Configuration

= @ Terminal/Group b anager
-
@ Befrezh
Make Default
Delete
R ename

Any group can be made the default group by clicking on the group, and then clicking on
the right mouse button. Then click on the Make Default option.

Reassigning Terminals

After a terminal has been configured and assigned to the default group, it can be
reassigned to a new group by clicking on the terminal icon as shown below.

Terminal Auto-Configuration

= E Terminal/Group Manager
EI@ Mew Group [Default]
T EiTENRERE
@ MNew Group1

Then, holding the mouse button down, drag the terminal icon to the desired group as
shown next.
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Terminal Auto-Configuration

=~ @ Teminal/Group Manager
El @ New Group [Default]

Release the mouse button, which reassigns the terminal.

Terminal Auto-Configuration

=] E Terminal/Group Manager
----- @ Mew Group [Default]
El @ M ew Groupl

207 241 78,

97

The next time the terminal is rebooted, it will be reconfigured as defined in the group
specification.

Mobile Device Manager (MDM) Features

Under Tools in Twin Client Manager are the Screen Watcher, Terminal Messenger, and
RF Monitor features.

Note: The terminal may or may not be able to utilize the Screen Watcher or Terminal
Messenger features depending on its Authorization codes.

Untitled - Twin Client Manager

File Terminal Object Editors  Settings N0 “iew Help
Dliﬁlnl .l'fll%l El EI Authorization. ..
Airloader...

Screen Watcher. .

T erminal Meszenger...
BF bMonitar...

Server Tranzfer...

Select Screen Watcher, enter the terminal’s IP address, and click on OK.

Screen Watcher

Enter the P Addresz of the Teminal:

|
(] I Cancel

A screen will appear with a display resembling the terminal screen.
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206.183.67.276 [ [T =]

Statuz: Connecting...

Clicking on the Font button on the upper left brings up a screen in which you can modify
the font settings, as shown below.

Eant; Font style:
aurnier Mew IHeguIar
e ] T
[talic
Finedsys Bold
T Lucida Console Bold Italic
B M5 Gothic
Terminal _I
— Effectz — Sample
[T Stikeout
[ Underline AaBbYYZ z
Caolaor;
I- Black ;l Script:
I"»-'-.-"estern j

Select Terminal Messenger from the Tools menu.

You may enter an Address Range in the From and To boxes on this screen. Click on Add
when finished.

Enter a message to send in the space provided, select the terminal to receive this message
by clicking on it in the Select Terminal(s) column, and click on the Send button to send
the message of your choice to the terminal of your choice.

See the example of the Terminal Messenger screen below.
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Terminal Messenger El

Enter the meszage to zend:

Select Terminallz):

—Addrezs Fange

To I

Select All |
Unzelect Al |

Ping [ Request Login Information

Add

Femove

Remowve Al

ik

I1ze Chrl and Shift keps to select mulkiple terminals

Send | Cloze

To remove a terminal from the list of terminals receiving your message, click on the
terminal number in the Select Terminal(s) column, and click on the Remove button.
Click on the appropriate button, Remove All, Select All, or Unselect All, to remove all
terminals, select all terminals, or unselect all terminals from the Select Terminal(s) list.

Note: Use the Ctrl and Shift keys to select multiple terminals.

Click on the Close button when finished.
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MDM’s Find and Identify Features

The Find feature enables the network manager to remotely turn a terminal on and cause it
to make an audible beep so that the terminal can be heard and located within the facility.
The configurable Identify feature enables you to track the last user of a hand held
terminal. The operator’s logging a password when a terminal session is started enables
the network manager to know who last used the device in the event that it is lost.

To cause the terminal to make audible beeps so that it can be located, enter the IP
address(s) of the terminal, highlight to select, and click on the Ping button.

Enter the meszage to zend:

Select Terminallz]:

— Addrezz Range

207,241 74
207.241,78.249 From: [207.241.78.248 1o [207.241.78.243

Add
Select Al

Femove

nzelect Al
Remowe All

Fing [ Request Login Infarmation

dil]
EE

I1ze Chrl and Shift keys to zelect multiple terminals

Send | Cloze

The TnPing screen will appear. When the terminal is located, it will beep continuously
until the user presses any key on the terminal.

Status |
Pinging 207.241.78.248 [207.241.78.248] with 32 bytes of data:
Replu[1] from: 207.241.78.248; bytes=32 time=h0mz TTL=128
Replu[2] from: 207.241.78.248; bytes=32 time=20mz TTL=128
Feply3] from; 207.241.73.248; butes=32 time=20mz TTL=128
Reply[4] from: 207.241.73.248; bytes=32 time=20mz TTL=128

Cloze |

Click on Close.
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To identify the person using the terminal, check Request Login Information.

Terminal Messenger 5[

Enter the mezsage to send:

Select Terminal(z]:

o07.241 76048 | | fadress Range
207.241.78.243 Frarm: |2n?.241 78242 14 |2n?.241 78,249

Select Al |
nzelect Al |

Ping ¥ Fequest Login Information

&dd

Remowve

Remowve Al

13

IJze Chil and Shift keys to zelect multiple terminals

Send | Cloze

Then from the main menu, select Terminal, and Send Configuration Files to Terminal.

On the terminal, enter the user’s name:

Username:

The username must be 6 characters long. Press Enter. Log in to the host as always.

Return to the Terminal Messenger screen, select the IP address, and click on Ping. This
requests the login information from the terminal. The login information is saved on the
PC in the PowerNet Twin Client directory in a file called login.txt. A sample of the file
appears as follows:

11:2?:16: 04-15-05, 207.241.78.248, 12%45

time date IP address  last login on
of terminal  the terminal
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E3 untitled - RFMonitor _[O)

Select RF Monitor from the Tools menu.

File Edit Achons: Tools “iew Help

Rleady [ NUM ,;;

RF Monitor is an "Over The Air" diagnostic tool. It is used to collect diagnostic trace
information from RF terminals running PowerNet Twin Client software.

It runs on a Windows PC and will send a command to the RF terminal to start tracing.
The terminal, when it receives this command, will start sending the trace information
over the RF link to the PC that issued the command. This will be written to a file on this
PC that can be sent to us for analysis.

Click on File to Select Terminal or to Exit.

E3untitled - RFMonitor
A Edit Actionz Toolz Yiew Help

Select Terminal...

E xit

Choosing Select Terminal allows you to view a log of the terminal’s activity. Enter the
Terminal IP address and Terminal IP Port, and click on OK.
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Select Terminal

Terminal IP Address:

Terminal IF Part: I-IEEI2
k. I Cancel |

Click on Edit. Select Find and/or Find Next to search for pieces of information in your
log, or select Clear to clear the search.

E2 Untitled - RFMonitor I =]

Eile @AW Action: Tool: ‘iew Help

Fitidk. [Efi{HF
sl RS
Clear

Click on Actions to select Start Monitor or Stop Monitor.

E3untitled - RFMonitor M= B3
Fie Edit |FR00eg Tools Yiew Help

| Stark b anitar
Stop i omtar

—

Click on Tools to choose Set Debug Levels or Settings.

E3 untitled - RFMonitor =]

EIlE E':ht ECHDHS II:||:||:5: HiEW ﬂElp
| ¢ | F SetDebuglevels.
[ Settings. .

The options in Set Debug Levels are shown below.
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%]

Debug Levels

General

Diizplay

Formatter

Dialog

Terminal [nkerface

Prezentation Space

[ atastream
[3270, 5250

SMA [3270)

o]

o i

1

&’
o [
o
L

To select a TCP connection (a UDP connection is the default), position the terminal at the
following prompt.
TwinClient
(c) 1991-2006 Connect
Keypress To Continue

On the PC, choose Tools and then choose Settings.

Click on the TCP radio button in the window that appears. The maximum log file size
can also be set here.

Settings §|

b axirnum log file size (KB]: 1000 _%I

Connection: ¢ UDP % TCP

| 4 | Cancel |

Click on the OK button.

Then click on the green button in RF Monitor, as shown below (the second button from
the left, under the File, Edit, Actions... menu).

F3untitled - RFMonitor

File Edit #ctions Tools Yiew Help

Ble o |F|®

Press Enter on terminal.
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Click on View to show or hide the Toolbar and the Status Bar.

E2 Untitled - RFMonitor _[O]
File Edit Actionz Toolz
| . |=E|? v Toolbar
[ » Statuz Bar
This is the Toolbar. It is found near the top of the screen.
[l o [E]2]
This is the Status Bar. It is found at the bottom of the screen.
Ready NI | i

Click on About RF Monitor under Help to view version number information. Click on
About Twin Client Manager under Help in the main menu to view the following screen.

About Twin Client Manager

7

Twin Client Manager
Verzion 720
Copyright [C] 2004, Connect, he.

T erminal Software Yersions:

k anufa... | T errminal

| E rulation | Werzion -

[ntellnst
[ntellnst
[ntellnst
[ntell st
[ntellnst
[ntellnst
[ntellnst
[ntell st
[ntellnst
[ntellnst
[ntellnst
[ntell st
[ntellnst

[ntellnst
4

LAMPaintkd abile
LAMPaintkd obile
LAMPaintkd obile
LanFointCE
LanPaintCE-AS
LanPointCE
LanPointCE-A5
LanFointCE
LanPaintCE-AS
LanPointCEdatMET
LanPointCEdotMET-45
LanFointCEdotMET
LanPointCEdatMET-AS
LanPointCEdatMET

WTERM
5250
3270
YTERM
WTERM
5250
5250
3270
3270
WTERM
YTERM
5250
5250
3270

£.31
.31
.31
7.0
1.0
1.0
1.0
7.0
1.0
1.0
1.0
7.0
1.0

I
I _>I_I

RF Monitor is a very small program and does not even require installation. Just place it in
a directory on your PC and create a shortcut to run it. It will run on all versions of
Windows except V3.1 and Windows 95.

1.

2.

Move RF Monitor to a Windows PC with Network access to the RF terminal.
Run RF Monitor. (Create a shortcut or do a Start/Run.)
From the pull down menu, select File/Select Terminal.

Key in the RF terminal IP address and leave the port at 1802.
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selectalEnminal 31

Terminal IP Address: |

Teminal IP Port: | 1802
k. | Cancel |

5. From the pull down menu, select Tools/Set Debug Levels. Set all levels to 9 except
Datastream and SNA.

Danije Eatys 31

General

Digplay

Farmatter

Dialog

Terminal Interface

Prezentation 5pace

D atastream
[3270, 5250

SHA [3270)

ok | Cancel |

B o A

6. With the RF terminal sitting at the Press Any Key prompt, select Actions/Start
Monitor.

7. Press a key on the RF terminal to open a session, and you should see trace data in the
RF Monitor window. When done, end the trace and the file will be named
tnxxx.yyy.log (Where xxx.yyy is the last 2 octets of the RF terminal’s IP address) in
the directory in which RF Monitor was running.
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F 210780324002 = REMonitor: M =E3
File Actions Tools View Help
B S
88711 11:57:55.084808 Bms Log Started.
88711 11:57:55.04889 58ms BEGIH 5258 6.5.8 IBM-5291-1 TH E:itnut.cf =—
#8711 11:57:55.0488 288ms TH key=0878_132< 8 vars (@)
88711 11:57:55.0088 5Oms Dialog File: *°
88/11 11:57:55.008 Bms Dialog "°
88711 11:57:57.08688 1760ms Connected To: 287.241.78.5
88711 11:57:57.0068 68ms tip snd: 2 bytes
51 @8 1.
88711 11:57:57.084808 SOms tip_rcu: 14 bytes
51 36 38 38 308 34 36 36 2E 33 2E 36 18 15 N6300466.3.6. .
88711 11:57:57.8488 68ms tip_setup: model 4B68A key 46 rev 630
B8/11 11:57:57.0888 168ms tip snd: 137 bytes
A B2 35 31 %A 82 41 31 A 65 42 31 30 38 30 5A 2.512.a12.B18862
B2 44 30 SA 85 46 33 32 34 30 SA 82 47 38 S5a 82 -DBZ_F324872 .GA2.
L9 B4 SA B2 4D 31 5A B2 4E 38 5A A9 58 34 2C 33 [.2.M12_.H8Z2_P4,3
32 2C 31 38 30 54 62 51 31 5A B2 52 38 59 82 42 2,1882 .01Z2.A8Y B
81 59 82 43 60 59 02 45 61 59 82 46 68 59 82 4N P i I, ] S ot e et
88 59 82 49 @1 58 83 42 08 00 58 @2 46 BA 58 @2 NoIX.B..K.F.X.
47 B8 58 B8 48 65 6E 67 6C 69 73 68 5A B2 56 6A G.%.-HenglishZ.\U.
A 11 48 31 2C 31 35 38 2C 32 38 34 38 2C 33 38 Z.H1,158,2848,38
Ready

Common Problems with RF Monitor

e The trace won’t start.

RF Monitor uses UDP to send commands to the RF device. On busy networks, UDP
packets are not always delivered. The terminal can miss the command to start the
trace. Below are some things that can be useful.

a. Ping the RF terminal from the PC used before starting RF Monitor. (This seems
to "open" a path to the terminal.)

b. Start the Monitor with the terminal at the Press Any Key prompt. (While the
terminal is at this prompt, it is not doing much and has a better chance of hearing
the start trace command.)

e | don't understand what this trace means.

The trace that this tool collects is engineering-level information. It allows an end user
to collect information that can be analyzed by Connect engineering.

It will generally be requested by Connect support to help diagnose a reported

problem.

To be able to read and understand these completely, you need to have an
understanding of:
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a. Emulation protocols (IBM 5250, IBM 3270, DEC VT200, etc.)
b. PowerNet Twin Client products

c. RF network concepts

d. Wired network concepts

e. Telnet sessions

f. TCP/IP

They are text files that can be read with any editor or viewer and can be useful to end
users and integrators, even if they may not have all the requirements above.

I have an intermittent problem and it could happen on any one of my 100
terminals. RF Monitor only does one terminal at a time. What can | do?

RF Monitor is not the right diagnostic tool for this type of problem. PowerNet
products have another diagnostic tool that can be used called the "Diagnostic Server".

This tool can be set up to run trace diagnostics on up to 300 terminals at the same
time. This tool will be provided as needed for systems under PowerNet support
agreement OR by T&M when they are not covered.

It also includes the service of a PowerNet support engineer.

Server Transfer is another feature. From the Tools menu, select Server Transfer.

Untitled - Twin Chent Manager M=l E3

File Teminal Object Editors  Settings [EEWEE YYiew Help

Dl@lnl lﬁlﬁl ﬂl il Lutharization. .

Airloader...

Screen ‘watcher...
Terminal Meszenger...
BF Maritar...

The FTP Settings screen appears.

FTP Settings

Server address: I

dzer ID: Iteu:

Paszword: I"’“"“‘“

] I Cancel

To send object editor and configuration files from Windows to your Linux box, enter
your server address, and click on OK.

2-44
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Sending Program and Configuration Files to the
Terminal

1. Boot the terminal.

2. On the PC, select Send Program Files to Terminal from the Terminal menu in Twin
Client Manager.

Eile Object Editors  Settings  Wiew Help
EI Send Configuration Files ta Terminal
Beceive File from T erminal .

| St Send Program Filez to T erminal

The following screen will appear.

Twin Client M anager

Fleaze werify that ActiveSpnc iz running. IF not,
connect the device to start ActiveSync. Then click

Dk, when ActiveSync iz running.

Cancel |

3. Click on OK.
The following screen will appear.

Twin Client Manager

& Tranzfer Complete.

4. Click on OK.

5. On the PC, choose Send Configuration Files to Terminal from the Terminal menu
in Twin Client Manager.

Untitled - Twin Client M anager

Eil= Object Editors - Settings Yiew Help

| IS Configuration Files to Terminal |

Beceive File from T erminal I

| L FPragram Files ta Terminal

You will see the following screen.
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Twin Client Manager |

& wiould pou alzo like to load the configuration files?

i Hao | Eancell

6. Choose Yes.

Twin Client Manager

Pleasze verity that ActiveSync is running. |F nok,
cohnect the device to start ActiveSync. Then click
Ok when ActiveSync iz unning.

Eanceq

7. Click on OK.
The following screen will appear.

Twin Client Manager [E3

& Tranzfer Complete.

8. Click on OK.

9. Warm boot the terminal.

Under Terminal, you may select Receive File from Terminal.

Eduntitled - Twin Client Manager =10l x|

File | Terminal ©bject Editors  Settings Tools  Wiew Help

0 Send Configuration Files to Terminal
Receive File From Terminal

| 3k gend Program Files o Terminal ,

Enter the path and file name to receive from the terminal in the Upload File dialog box.
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Upload File x|

Enter the path and file name to
receive fram the terminal:

ak. I Cancel

The default file is “rf.log”. Click on OK.
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Chapter 3 - Keypad Configuration

Diagrams

The keypad diagrams begin on the following page.

Supported Equipment Manual e May, 2006 3-1
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vt emulation

CF ]| le[ Sear }[ F3 J [_F4 )

[ Enter ] Enter ]

F11 F12 F13
1 2 3

home vwup A

F14  F15 F5 F16 F6

vwif <« vw rt >

o108t
OI0AS

F17 _ F7 F18 F8 F19 F9

R 8 9 |+ =

endps VW dn v

()
O30

< , F20___F10 > __ space
0 bksp
delchar inschar
COCOCOCOTD
: ; “ ‘ prtsc
? / ~ b setup

caps lock ctrl

Shift+Func Func

Shift Num lock

3-2
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3270 emulation L F1 ) F2 ) Seo (F3 ) [ F4 )

| Enter | [ Enter |

F21  F11  F22 F12  F23 F13

home vwup A

@ *
F24 F14 F15 F5 F16 F6
@

vw If < vw rt >

F17_F7 F18__F8 F19__F9

o308t

% 7 8 9 P
endps vw dn v

) F20 F10 > space

-

() (7

delchar inschar

print sysreq reset

DO
OB

caps lock pa1l

G GO G

Shift+Func Func

Note: The key sequence
for pa3 is: <Func><Z><Z>

Shift Num lock
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5250 emulation

(F1 ] [ F2] (F3 ) [ F4]
Scan
[ Enter ] [ Enter ]
F21  F11 F22 F12 F23  F13
I & home vwup A rdn @ *
@ F24 F14 F15 F5 F16  F6
4 5 6
# ( $ )
vw If | vw rt >
F17 _ F7 F18 __F8 F19 _ F9
% 7 8 9 + =
| \ < ) F20 _F10 > _ space i
O G O
delchar inschar
{ } fexit erinp help field-
? / ~ h dup clea attn

caps lock

Shift+Func Func

Shift Num lock

34
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Table

Key VT 3270 5250

a <A> <A> <A>

b <B> <B> <B>

c <C> <C> <C>

d <D> <D> <D>

e <E> <E> <E>

f <F> <F> <F>

g <G> <G> <G>

h <H> <H> <H>

i <|> <|> <|>

i <J> <J> <J>

k <K> <K> <K>

| <L> <L> <L>

m <M> <M> <M>

n <N> <N> <N>

o <0O> <0O> <0O>

p <p> <p> <p>

q <Q> <Q> <Q>

r <R> <R> <R>

s <S> <S> <S>

t <T> <T> <T>

u <U> <U> <U>

v <V> <\V/> <\V/>

w <W> <W> <W>

X <X> <X> <X>

y <Y> <Y> <Y>

z <Z> <Z> <Z>

A <Shift><A> <Shift><A> <Shift><A>
B <Shift><B> <Shift><B> <Shift><B>
Cc <Shift><C> <Shift><C> <Shift><C>
D <Shift><D> <Shift><D> <Shift><D>
E <Shift><E> <Shift><E> <Shift><E>
F <Shift><F> <Shift><F> <Shift><F>
G <Shift><G> <Shift><G> <Shift><G>
H <Shift><H> <Shift><H> <Shift><H>
I <Shift><I> <Shift><I> <Shift><I>
J <Shift><J> <Shift><J> <Shift><J>
K <Shift><K> <Shift><K> <Shift><K>
L <Shift><L> <Shift><L> <Shift><L>
M <Shift><M> <Shift><M> <Shift><M>
N <Shift><N> <Shift><N> <Shift><N>
o) <Shift><0> <Shift><0> <Shift><0>
P <Shift><P> <Shift><pP> <Shift><pP>
Q <Shift><Q> <Shift><Q> <Shift><Q>
R <Shift><R> <Shift><R> <Shift><R>
S <Shift><S> <Shift><S> <Shift><S>
T <Shift><T> <Shift><T> <Shift><T>
U <Shift><U> <Shift><U> <Shift><U>
\" <Shift><V> <Shift><V> <Shift><V>
w <Shift><W> <Shift><W> <Shift><W>
X <Shift><X> <Shift><X> <Shift><X>
Y <Shift><Y> <Shift><Y> <Shift><Y>
Y4 <Shift><Z> <Shift><Z> <Shift><Z>
1 <1> <1> <1>

2 <2> <2> <2>

3 <3> <3> <3>

4 <4> <4> <4>

5 <5> <5> <5>

6 <6> <6> <6>

7 <7> <7> <7>

8 <8> <8> <8>

9 <9> <O> <9>
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0 <0> <0> <0>

F1 <F1> <F1> <F1>

F2 <F2> <F2> <F2>

F3 <F3> <F3> <F3>

F4 <F4> <F4> <F4>

F5 <Func><5> <Func><5> <Func><5>

F6 <Func><6> <Func><6> <Func><6>

F7 <Func><7> <Func><7> <Func><7>

F8 <Func><8> <Func><8> <Func><8>

F9 <Func><9> <Func><9> <Func><9>
F10 <Func><0> <Func><0> <Func><0>
F11 <Func><1> <Func><1> <Func><1>
F12 <Func><2> <Func><2> <Func><2>
F13 <Func><3> <Func><3> <Func><3>
F14 <Func><4> <Func><4> <Func><4>
F15 <Shift><Func><5> <Shift><Func><5> <Shift><Func><5>
F16 <Shift><Func><6> <Shift><Func><6> <Shift><Func><6>
F17 <Shift><Func><7> <Shift><Func><7> <Shift><Func><7>
F18 <Shift><Func><8> <Shift><Func><8> <Shift><Func><8>
F19 <Shift><Func><9> <Shift><Func><9> <Shift><Func><9>
F20 <Shift><Func><0> <Shift><Func><0> <Shift><Func><0>
F21 <Shift><Func><1> <Shift><Func><1>
F22 <Shift><Func><2> <Shift><Func><2>
F23 - <Shift><Func><3> <Shift><Func><3>
F24 - <Shift><Func><4> <Shift><Func><4>
Alt <Func><Z> <Func><Z> <Func><Z>
Attn <Func><W> <Func><W>
Caps lock <Func><Shift> <Func><Shift> <Func><Shift>
Clear - <Func><V> <Func><V>
Ctrl <Func><X>
Delchar <Num lock><.> <Num lock><.> <Num lock><.>
Dup - <Func><U> <Func><U>
Endpos <Num lock><7> <Num lock><7> <Num lock><7>
Ereof --- <Func><J> -

Erinp <Func><K> <Func><K>
Field exit - --- <Func><J>
Field minus - --- <Func><M>
FM <Func><M>

Help <Func><L> <Func><L>
Home <Num lock><1> <Num lock><1> <Num lock><1>
Inschar <Num lock><0> <Num lock><0> <Num lock><0>
Pa1 --- <Func><X> -

Pa2 --- <Func><Y> ---

Pa3 --- <Func><Z><Z> -

Print --- <Func><P> <Func><P>
PrtSc <Func><P> -—- -

Reset <Func><R> <Func><R>
Roll up - - <Num lock><9>
Roll down - --- <Num lock><3>
Setup <Func><U>

Space <Func><Bksp> <Func><Bksp> <Func><Bksp>
Sys req - <Func><Q> <Func><Q>
View up <Shift><2> <Shift><2> <Shift><2>
View left <Shift><4> <Shift><4> <Shift><4>
View right <Shift><6> <Shift><6> <Shift><6>
View down <Shift><8> <Shift><8> <Shift><8>

A <Num lock><2> <Num lock><2> <Num lock><2>
< <Num lock><4> <Num lock><4> <Num lock><4>
> <Num lock><6> <Num lock><6> <Num lock><6>
v <Num lock><8> <Num lock><8> <Num lock><8>
< less than <Shift><Func><.> <Shift><Func><.> <Shift><Func><.>
, comma <Func><.> <Func><.> <Func><.>

> greater than <Shift><Func><Bksp> <Shift><Func><Bksp> <Shift><Func><Bksp>
! exclamation <Shift><Func><A> <Shift><Func><A> <Shift><Func><A>
& ampersand <Func><A> <Func><A> <Func><A>
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@ at sign <Shift><Func><B> <Shift><Func><B> <Shift><Func><B>
* asterisk <Func><B> <Func><B> <Func><B>

# pound <Shift><Func><C> <Shift><Func><C> <Shift><Func><C>
(_ left parenthesis <Func><C> <Func><C> <Func><C>

$ dollar <Shift><Func><D> <Shift><Func><D> <Shift><Func><D>
) right parenthesis <Func><D> <Func><D> <Func><D>

A carat <Shift><Func><E> ---

% percent <Func><E> <Func><E> <Func><E>

+ addition sign <Shift><Func><F> <Shift><Func><F> <Shift><Func><F>
= equal sign <Func><F> <Func><F> <Func><F>

| vertical bar <Shift><Func><G> <Shift><Func><G> <Shift><Func><G>
\ backslash <Func><G> <Func><G> <Func><G>

_ underscore <Shift><Func><H> <Shift><Func><H> <Shift><Func><H>
- hyphen <Func><H> <Func><H> <Func><H>

{ left brace <Shift><Func><I> <Shift><Func><I> <Shift><Func><I>
[ left bracket <Func><I> -—- -—-

} right brace <Shift><Func><J> --- ---

1 right bracket <Func><J> - -

: _colon <Shift><Func><N> -—- -—-

; _semicolon <Func><N> <Func><N> <Func><N>

“ quotes <Shift><Func><0> <Shift><Func><0O> <Shift><Func><0O>
‘ apostrophe <Func><0O> <Func><0O> <Func><0O>

? question mark <Shift><Func><S> <Shift><Func><S> <Shift><Func><S>
| forward slash <Func><S> <Func><S> <Func><S>

~ tilde <Shift><Func><T> <Shift><Func><T> <Shift><Func><T>
| = grave accent <Func><T> <Func><T> <Func><T>

Note: The Shift key and the Function key retain their pressed state after released.
To change this, go to Start > Settings > Control Panel > Accessibility Options,
or depress the Shift key 5 times.

The Nav Lock key sets the numeric keypad to the navigation keys.

Once depressed, the yellow light next to the key will activate.
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Chapter 4 » Error Message Resolution Guide

Twin Client Error Message Resolution Guide

Message Reason Solution Reference Tech Note

ENTRY TOO LONG; Trying to key beyond the field size. Ensure that you are entering input into the -
correct field.

ALPHABETIC ONLY; Trying to key a character that is not Ensure that you are entering input into the -
alphabetic. correct field.
MINUS NOT VALID; Trying to key a Minus sign. Ensure that you are entering input into the -

correct field.

DECIMAL NOT VALID; Trying to key a Decimal (period).  Ensure that you are entering input into the -
correct field.

ALPHANUMERIC ONLY; Trying to key characters other than Ensure that you are entering input into the -
Alphabetic and numeric. correct field.

NUMERIC ONLY; Trying to key characters other than Ensure that you are entering input into the -
numeric. correct field.

ENTRY TOO SHORT; Trying to exit the field before itis  Ensure that you are entering input into the -
filled. correct field.
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Message Reason Solution Reference Tech Note

INVALID KEY; The key pressed is not valid. Ensure that you are entering input into the -
correct field.

MUST CLEAR FIELD; Trying to enter data in a field that  Ensure that you are entering input into the -
must be cleared first. correct field.
SCAN NOT ALLOWED; Trying to scan into a key only field. Ensure that you are entering input into the -

correct field.

KEY NOT ALLOWED; Trying to key into a scan only field. Ensure that you are entering input into the -
correct field.

ENTRY TOO SHORT; Trying to exit the field before itis  Ensure that you are entering input into the -
filled. correct field.
RECOVERABLE ERROR; Encountered an error from which  Verify that your configuration settings for the -
you can continue. hardware being used, usually a printer and
cable issue.
UNRECOVERABLE ERROR; Encountered an error from which  Verify that your Network settings are correct T1113, T1114, T1161,
you can NOT continue. and you are in the correct mode using the T1171, T1187 and
correct Port. T1194
FUNCTION: \n\nFILE: \nLINE: \nCODE; Encountered an error from which  Notify Connect over the web incident -
you can NOT continue. reporting system.
Press any key\nFor More Details...; Press Enter for more information.  Advisory message. -
Press any key; Press a key to continue. Advisory message. -
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Message

Connection ERROR.\nREBOOT
MOBILE UNIT;

Disconnect ERROR.\nREBOOT
MOBILE UNIT;

RF Send ERROR.\nREBOOT MOBILE
UNIT;

RF Receive ERROR.\nREBOOT
MOBILE UNIT;

RF Check ERROR.\nREBOOT
MOBILE UNIT;

RF Timeout ERROR.\nREBOOT
MOBILE UNIT;

REBOOT MOBILE UNIT;

Reason

Could not Connect.

Could not Disconnect.

Could not Send.

Could not Receive.

Could not run the RF Survey.

Have been trying to contact the
host for the radio timeout period (2
minutes default).

Reboot the Mobile Unit do to loss
of connection.

Solution

Reference Tech Note

Verify that your Network settings are correct T1113, T1114, T1161,

and you are in the correct mode using the

correct Port.

T1171, T1187 and
T1194

Verify that your Network settings are correct T1113, T1114, T1161,

and you are in the correct mode using the

correct Port.

Most likely a range, access point, radio,
host or network issue. Troubleshoot the
customer’s environment.

Most likely a range, access point, radio,
host or network issue. Troubleshoot the
customer’s environment.

Most likely a range, access point, radio,
host or network issue. Troubleshoot the
customer’s environment.

Most likely a range, access point, radio,
host or network issue. Troubleshoot the
customer’s environment.

Most likely a range, access point, radio,
host or network issue. Troubleshoot the
customer’s environment.

T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194

Retry (Y/N)?; Try again. Try to send or receive again, or perhaps -
ensure that the printer is cabled to the
Mobile Unit and is on.
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Message

TIMEOUT\n\nSending Data;

TIMEOUT\n\nReceiving Data;

Host Received Data\nAwaiting App
Reply!;

* WAITING TO SEND *;

TCP Error Reading\nMAC
Address.\nREBOOT MOBILE UNIT;

Invalid TIP Command;

Session Ended\nBy User or Host;

Server Packet Error;

Reason

Mobile Unit out of the coverage
area.

Mobile Unit out of the coverage
area.

Mobile Unit has sent and received
an acknowledgement from the IP
stack and is waiting for the
application to return data.

Mobile Unit out of the coverage
area.

Could not obtain the Mac Address
from the Mobile Unit.

Bad internal protocol.

User, Host, application or network
has ended the session.

Bad Protocol detected.

Solution

Most likely a range, access point, radio,
host or network issue. Troubleshoot the
customer’s environment.

Most likely a range, access point, radio,
host or network issue. Troubleshoot the
customer’s environment.

Most likely a host or network issue.
Troubleshoot the customer’s environment.
Probable causes are Database record
locking, application program failure, Host
failure or network failure.

Most likely a range, access point, radio,
host or network issue. Troubleshoot the
customer’s environment.

Possible hardware, driver or stack problem
Contact the Mobile Unit manufacturer.

Notify Connect over the web incident
reporting system.

If the user did not end the session, most
likely host or network issues. Troubleshoot
the customer’s environment.

Usually a result of bad cabling, power or
faulty transceiver. Also, will receive this if
the Mobile Unit is in the wrong mode for

Server operation.

Reference Tech Note

T1113, T1114, T1161,
T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194
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Message

Error receiving host\nlist from Server;

Unexpected Server\ndata received;

Error starting\nhost application;

Select Host or App;

Connecting...;

TCP Error\nReading IP
Address\nREBOOT MOBILE UNIT;

Printer start error;

Battery too low\nto print;

Paper Feed Error\nFix Then Hit Enter;

Printer Error\nPrint Ended;

Reason

Bad Protocol detected.

Bad Protocol detected.

Connected to the server but can
not connect to the distant end.

Need to choose your
Host/application destination.

Attempting to connect to the
Host/application.

Mobile Unit missing Network IP
information.

Could not initialize the printer.

Not enough power to print.

Paper in the printer is not ready.

Can not print.

Solution

Usually a result of bad cabling, power or
faulty transceiver. Also, will receive this if
the Mobile Unit is in the wrong mode for

Server operation.

Usually a result of bad cabling, power or
faulty transceiver. Also, will receive this if
the Mobile Unit is in the wrong mode for

Server operation.

Configure the server handler to access the
host application.

User selection required.

Advisory message

Configure the Mobile Unit with the correct
network IP information.

Cable or power issue with the printer.
Replace the battery with a fully recharged
battery.

Replace the paper or rethread the paper in
the printer.

Check cable, battery, communication
settings and paper in the printer.

Reference Tech Note
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Message

User Count Exceeded.\n Session
Ended;

Primary Unavailable\nTrying Alternate;

APMAC.DAT Error\nSession Ended;

MUIP.DAT Error\nSession Ended;

Missing Subnet IP\nSession Ended;

Error Opening File;

Telnet API\nnot found;

Battery Low Warning\n\nReplace
Battery Soon;

No Host List.\nPress any key\nTo Edit
Host IP's;

Unable to Allocate\nFont Memory;

Reason Solution

Possible authorization issue. Verify that you have the correct number of
licenses for the number of Mobile Units you
are using.

First Host IP address not available Verify the host address.
trying the remaining addresses in

the Host list.

Access point Media Access Control Most likely a range, access point, radio,

error. host or network issue. Troubleshoot the
customer’s environment.

Mobile Unit IP Error. Most likely a Mobile Unit network setting
issue. Troubleshoot the customer’s
environment.

Mobile Unit IP Netmask Error. Most likely a Mobile Unit network setting
issue. Troubleshoot the customer’s
environment.

File is missing. Verify that the configuration files are on the
Mobile Unit. Or perhaps there is a hardware
failure.

Program files are missing. Reload program files.

Not enough power to operate the  Replace the battery with a fully recharged
Mobile Unit. battery.

Have not configured your target Configure the target host IP addresses.
hosts.

Mobile Unit does not have enough Reduce the fonts in use or expand the
memory to load the fonts. memory in the Mobile Unit.

Reference Tech Note

T1113, T1114, T1161,
T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194
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Message Reason Solution Reference Tech Note
Font Loading Error; Could not load the font. Ensure that the font is available to load. -

Printer Not Ready\nPress R to Can not print. Check cable, battery, communication -
Retry\nC to Cancel Print; settings and paper in the printer.

Mobile Unit in\nDemonstration Running in demo mode. Purchase a license from Connect.

Mode\nfor TwinClient;

Connected to Host; Successful connection to the target Advisory message -
Host.

Telnet Mode not\nsupported on\nthis ~ This Mobile Unit must be used with Order a Connect Server. -

Mobile Unit; a Connect Server.
Telnet Setup files\nnot found. Customer specific configuration Load the configuration files into the Mobile -
Reload\nfiles then switch; files are missing. Unit from Twin Client Manager.

Switched Client to\nTelnet Direct Mode; Mobile Unit running in Telnet mode Advisory message -
direct to the target Host.

Switched Client to\nServer Based Mobile Unit running through a Advisory message -
Mode; Connect server in Server mode

usually at port 1800.
Port 23 is only\nallowed in Telnet Can not set the port to 23 in Server Advisory message ---
Mode; mode. Port 23 is the standard

Telnet port.
Not Enough Memory\nTo Run; Mobile Unit does not have the Expand the Mobile Unit memory. -

capacity to run the program do to
memory restrictions.

Press any key; Press a key to continue. Advisory message -
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Message Reason Solution Reference Tech Note
TwinClient Telnet; Prompt Advisory message -
TwinClient Server, Prompt Advisory message —
TwinClient TN3270; Prompt Advisory message -
TwinClient TN5250; Prompt Advisory message -
TwinClient TNVT; Prompt Advisory message -

(c) 1991-2006 Connect; Prompt Advisory message —

Edit Menu Options; Menu Title Advisory message -

Edit Mobile Unit IP; Menu Option Advisory message -

Edit Server/Host IPs; Menu Option Advisory message -

Edit Radio Option; Menu Option Advisory message -
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Message

Edit License Key;

Run Site Survey;

Switch Client Modes;

Run TwinClient;

Exit to OS;

Reason

Menu Option

Menu Option

Menu Option

Menu Option

Menu Option

Solution

Advisory message

Advisory message

Advisory message

Advisory message

Advisory message

Reference Tech Note

Printer may not be\nplugged in Can not print. Check cable, battery, communication -
or\nturned on!; settings and paper in the printer.
OUT OF RANGE OF BASE; Mobile Unit out of the coverage Most likely a range, access point, radio, T1113, T1114, T1161,
area. host or network issue. Troubleshoot the T1171, T1187 and
customer’s environment. T1194
CONNECT SERIAL CABLE; Serial cable not connected to the  Check cable, battery and communication -
Mobile Unit. settings for the Mobile Unit.
REMOVE SERIAL CABLE; Remove serial cable from to the Check cable, battery and communication -
Mobile Unit. settings for the Mobile Unit.
PLACE IN CRADLE; Place the Mobile Unit in the cradle. Advisory message
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Message

REMOVE FROM CRADLE;

ACQUIRING CRADLE BUS;

Printer Out\nOf Range;

Connection Refused\nBy Host;

Connection Timed Out;

Connection Failed\nHost Not
Responding;

Connection Failed\nHost Unreachable;

Mobile Unit Out\nOf Range,
Unable\nTo Transmit;

Mobile Unit Out\nOf Range,
Unable\nTo Receive;

Reason

Remove Mobile Unit from the
cradle.

Attempting to access the cradle
through the serial port you have
configured.

Printer out of the coverage area.

You connected to the target host

but the host disconnected you.

You connected to the host but did
not logon in the appropriate time so

the host disconnected you.
Could not connect to the Host.

Could not connect to the Host.

Mobile Unit out of the coverage
area.

Mobile Unit out of the coverage
area.

Solution

Advisory message

Advisory message

Most likely a range, access point or radio
issue. Troubleshoot the customer’s
environment.

Verify that the configuration file has the
correct Mobile Unit type and New
environment variable set. Fallback to the
Connect Default to verify the connection.

Modify the Host parameters for login.

Most likely a range, access point, radio,
host or network issue. Troubleshoot the
customer’s environment.

Most likely a range, access point, radio,
host or network issue. Troubleshoot the
customer’s environment.

Most likely a range, access point, radio,
host or network issue. Troubleshoot the
customer’s environment.

Most likely a range, access point, radio,
host or network issue. Troubleshoot the
customer’s environment.

Reference Tech Note

T1113, T1114, T1161,
T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194
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Message

Printer Not\nResponding;

Printer Out\nOf Range;

Print Complete;

Reprint (Y/N)?;

WARNING;

Turning power off\nduring a
session\nwill cause the\nprogram to
restart;

Are you sure (y/n)?;

You Sure? (YyNn);

Domain Name Server\nNot Set;

Reason

Can not print.

Printer out of the coverage area.

Prompt

Yes or No prompt for a reprint

Prompt

This Mobile Unit will disconnect the
session if powered off.

Yes or No prompt for a
confirmation

Yes or No prompt for a
confirmation

DOMAIN NAME SERVER not
configured.

Domain Name Server\nQuery Memory Memory error on the Mobile Unit

Error;

Solution

Check cable, battery, communication
settings and paper in the printer.

Most likely a range, access point or radio
issue. Troubleshoot the customer’s

environment. T1194

Advisory message

Advisory message

Advisory message

Mobile Unit manufacturer limitation.

Advisory message.

Advisory message

Advisory message

Configure the Mobile Unit with the correct
network IP information.

Expand the Mobile Unit memory or return
the Mobile Unit for repair.

Reference Tech Note

T1113, T1114, T1161,
T1171, T1187 and
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Message Reason Solution Reference Tech Note

Domain Name Server\nQuery Sending Mobile Unit out of the coverage Most likely a range, access point, radio, T1113, T1114, T1161,

Error; area. host or network issue. Troubleshoot the T1171, T1187 and
customer’s environment. T1194

Domain Name Server\nQuery Receive Mobile Unit out of the coverage Most likely a range, access point, radio, T1113, T1114, T1161,

Error; area. host or network issue. Troubleshoot the T1171, T1187 and
customer’s environment. T1194

Domain Name Server\nUnavailable; Could not connect to the DOMAIN Most likely a range, access point, radio, T1113, T1114, T1161,

NAME SERVER. host or network issue. Troubleshoot the T1171, T1187 and
customer’s environment. T1194
Error loading\nparameter file; Could not load the parameter file. Reload the correct configuration files. -
Could not open\ntelnet interface; Could not Telnet. Reload the program files. -—-
Could not set\mtelnet options; Could not use the Telnet Reload the correct configuration files. -
configuration.

Setup file\nsetting mismatch\nReload = Emulation program selected is not Remove the emulation and configuration -

Setup; compatible with the configuration files. Run clear Telnet on the Mobile Unit
file on the Mobile Unit. then reload the Mobile Unit with the proper
emulation and configuration files.
Display formatting\ntoo large Mobile Unit does not have enough Expand the Mobile Unit memory or order a -
for\ncurrent screen; memory to run your configured server from Connect.
reformatted screens.
Mobile Unit\ninitialization error; Mobile Unit problem. Return the Mobile Unit to the manufacturer -
for repair.
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Message

Host/App/Network\nclosed the session;

Disconnecting...;

Scan Barcode;

Enter Setup\nPassword;

Enter Profile \nPassword;

Host IP;

Host Name;

Port;

Mobile Unit Type;

Reason

Customer’s environment

disconnected the Mobile Unit

session.

Prompt

Bar code scanning test

Prompt

Prompt

Host IP address prompt.

Host name prompt.

Host IP port required.

Prompt

WARNING: This will \nend any\ncurrent Prompt

session;

Solution

Most likely a range, access point, radio,
host or network issue. Troubleshoot the
customer’s environment.

Advisory message

Advisory message

Advisory message

Advisory message

Enter target host IP address.

Enter target host Name.

Enter 23 for Telnet or 1800 for a Connect
Server. Could also be a different number

depending on the customer’s environment.

Advisory message

Advisory message

Reference Tech Note

T1113, T1114, T1161,
T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194
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Message Reason Solution Reference Tech Note
Continue (Y/N)?; Prompt Advisory message -

HOST ENTRY; Prompt Advisory message -—
VT(100/220) Setup; Prompt Advisory message -

Mobile Unit Info; Prompt Advisory message —
Emulation Setup; Prompt Advisory message -

ANSI Setup; Prompt Advisory message -—
Miscellaneous Setup; Prompt Advisory message -

Mobile Unit Type; Prompt Advisory message -

Control Codes; Prompt Advisory message -

Local Echo; Prompt Advisory message -
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Message Reason Solution Reference Tech Note
<BK SP> Sends; Prompt Advisory message -

New Line Mode; Prompt Advisory message -

Insert Mode; Prompt Advisory message -
Autowrap Mode; Prompt Advisory message -

Cursor; Prompt Advisory message -
EMULATION SETUP; Prompt Advisory message -

Mobile Unit Type; Prompt Advisory message -

Local Echo; Prompt Advisory message -

Map Underline; Prompt Advisory message -

Break Key; Prompt Advisory message -
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Message

ANSI Setup;

Control Codes;

Backspace Key;

MISCELLANEOUS SETUP;

Test Options;

Login Options;

TEST OPTIONS;

Printer Test;

Scan Code Test;

LOGIN OPTIONS;

Reason

Prompt

Prompt

Prompt

Prompt

Prompt

Prompt

Prompt

Prompt

Prompt

Prompt

Solution

Advisory message

Advisory message

Advisory message

Advisory message

Advisory message

Advisory message

Advisory message

Advisory message

Advisory message

Advisory message

Reference Tech Note
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Message Reason Solution Reference Tech Note
User Name; Prompt Advisory message -
User Password; Prompt Advisory message -
ON; Prompt Advisory message -
OFF; Prompt Advisory message -
Map; Prompt Advisory message -
Don't Map; Prompt Advisory message -
Enable Break; Prompt Advisory message -
Disable Break; Prompt Advisory message
7 bit; Prompt Advisory message -
8 bit; Prompt Advisory message —

Supported Equipment Manual e May, 2006 4-17



Error Message Resolution Guide

Message

Send Delete;

Send Backspace;

Mobile Unit Setup;

Scanner Options;

Program Options;

Special Options;

Beeper Options;

Exit to DOS;

Backlight Time;

Enter Key Action;

Reason

Prompt

Prompt

Prompt

Prompt

Prompt

Prompt

Prompt

Prompt

Prompt

Prompt

Solution

Advisory message

Advisory message

Advisory message

Advisory message

Advisory message

Advisory message

Advisory message

Advisory message

Advisory message

Advisory message

Reference Tech Note
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Message

Reset Options;

Font Size;

Portable Printer;

Reprint Option;

Data IDs;

Internal/External;

Modify Beeps;

Message Beeps;

Scan |dentifier;

AID Scan Setup;

Reason

Prompt

Prompt

Prompt

Prompt

Prompt

Prompt

Prompt

Prompt

Prompt

Prompt

Solution

Advisory message

Advisory message

Advisory message

Advisory message

Advisory message

Advisory message

Advisory message

Advisory message

Advisory message

Advisory message

Reference Tech Note
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Message Reason Solution Reference Tech Note
Long Scans; Prompt Advisory message -
Scan Send; Prompt Advisory message -
Yes; Prompt Advisory message -
No; Prompt Advisory message -
Normal, Prompt Advisory message -
Double Wide; Prompt Advisory message -
Double High; Prompt Advisory message -
Double High and Wide; Prompt Advisory message —
Errors Only; Prompt Advisory message -
Automatic; Prompt Advisory message -
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Message Reason Solution Reference Tech Note
All Messages; Prompt Advisory message -

Reject; Prompt Advisory message -
Truncate; Prompt Advisory message -

Split; Prompt Advisory message —--

Do Not Send; Prompt Advisory message -

Always Send; Prompt Advisory message -—

Last Field Only; Prompt Advisory message -

Internal; Prompt Advisory message -

External; Prompt Advisory message -

none; Prompt Advisory message -—
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Message Reason Solution Reference Tech Note
monarch; Prompt Advisory message -

pddumb; Prompt Advisory message -

comtec; Prompt Advisory message -

rascal; Prompt Advisory message -
codewriter; Prompt Advisory message -
comtec(S); Prompt Advisory message -

User Name; Prompt Advisory message -
Password; Prompt Advisory message -—
Frequency: Hz; Prompt Advisory message
Duration: ms; Prompt Advisory message
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Message Reason Solution Reference Tech Note
Delay: ms; Prompt Advisory message
Select Scanner; Prompt Advisory message -
Setup Scanner; Prompt Advisory message -
Scan Test; Prompt Advisory message -—
Scan Operation; Prompt Advisory message -
Laser; Prompt Advisory message —-
Contact/Pulse; Prompt Advisory message -
Contact/No Pulse; Prompt Advisory message —
Auto/Pulse; Prompt Advisory message -
Auto/No Pulse; Prompt Advisory message -
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Message Reason Solution Reference Tech Note
Wand Simulation; Prompt Advisory message -—

VT100; Prompt Advisory message -

VT220; Prompt Advisory message -

SETUP; Prompt Advisory message -

Mobile Unit IP/Radio; Prompt Advisory message —

Host List; Prompt Advisory message -

NULL; Prompt Advisory message -
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